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Introduction to Getting Started with Thunderbird 3.1

Introduction to Getting Started with Thunderbird 3.1
This document is a guide written for the Ubuntu Vancouver Local Community, or Ubuntu Vancouver 
LoCo (UVLC), on how to install Mozilla Thunderbird 3.1 in Ubuntu 10.10. It is the companion document 
to Taming Your Email with Thunderbird 3.1, a guide to managing a heavy email load with Thunderbird. 

If you already have Thunderbird installed, and your email accounts are configured, feel free to check out 
the Taming Your Email in with Thunderbird 3.1 guide on the Ubuntu Vancouver LoCo website. The 
Ubuntu Vancouver LoCo is an Ubuntu users group for Vancouver, Canada, and is a great place for 
learning about, and sharing your passion for all things Ubuntu. The Taming Your Email with Thunderbird  
3.1 guide can be found on the UVLC website under Discussions > Message Board > Technical Support:

http://www.meetup.com/ubuntuvancouver/messages/boards/forum/1245793

This guide will follow an Ubuntu user, named Mary, who has just decided to install Thunderbird. We will 
accompany Mary as she installs Thunderbird and then sets up her email accounts. Mary also wants to 
import her existing email messages and contacts into Thunderbird, and we will see how easily this can be 
done. 

Because nothing stays the same, least of all computer programs, there are sure to be changes to future 
versions of Thunderbird that are not reflected in this document. That is where you come in. If you find 
that things “just don't seem right”, it could be because this guide was written for an earlier version of 
Thunderbird than you have. Please feel free to ask for help, or mention the changes, on the Ubuntu 
Vancouver LoCo discussion boards. Your assistance will help us keep this guide up to date. After all, 
helping each other is the spirit that makes Ubuntu great! 

http://www.meetup.com/ubuntuvancouver/
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Getting Started With Thunderbird 3.1
“I have just too much email!”

“Are you sure you sent it to me? I don't see it.”

“Arrgh!!”

Ever use any of these statements when dealing with your email? Is your 
Inbox starting to feel like a dark and forbidding jungle? It is time to tame 
the wilderness with Mozilla Thunderbird 3.1. 

By default, Ubuntu 10.10 comes with the Evolution groupware client, but 
not all users need, or want it, for their email messaging. Enter 
Thunderbird. Thunderbird is a free email client produced by Mozilla, the 
same folks that make Firefox. It has been around for years, but with the 
release of version 3.1 and some great new features, Thunderbird is even 
better than ever.

1 Introducing Mary, an Email User Under Siege
Mary is an email user with a problem. She has three email accounts, each with 
hundreds of email messages, and every day Mary receives dozens of new 
messages. She is suffering from 'email overload'! Mary tries to keep up to the 
barrage of email, but checking multiple email accounts for new mail, and then 
deciding what is important and what isn't, seems to take all her time. Unlike 
'snail mail', email may save trees, but the forest has sprung up in her Inbox.

Mary needs help!

1.1  Why does Mary want to use Thunderbird
Ubuntu comes with a perfectly good email client installed by default; Evolution. If you don't want to use 
Evolution, there are also many free webmail services. So why does Mary want to use Thunderbird? There 
are a few reasons:

• Evolution is a groupware client that deals with, not just email, but also calendars, to-do lists and 
notes. Evolution will also connect to the email systems that many business run for internal email. 
Frankly, that is way more than Mary needs. All she is looking for is a program that manages her 
Internet email.

• Thunderbird is a commonly used email client on all the major computer operating systems, like 
Linux, Macintosh and Windows. Once Mary is familiar with Ubuntu Thunderbird, she can use it 
on any computer, even the Windows computer her boss forces her to use!

• There is a huge community of Thunderbird users and developers. With so many people using 
Thunderbird, when Mary needs help, there is sure to be someone who can answer her questions. 
She can also chose from thousands of free additions to Thunderbird that extend its functionality.

• Webmail services leave you at the mercy of the webmail provider. They can make changes to their 
service at any time, or even discontinue it.
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• The features of webmail services are generally quite limited. Mary prefers the vast number of 
features that she gets with Thunderbird.

• Mozilla Thunderbird is developed right here in Vancouver, so not only is Mary supporting a local 
product, but the Ubuntu Vancouver Local Community can help shape future versions.

1.2  Using this guide

Follow Mary as she installs Thunderbird

Up until now, Mary has been using a few different webmail accounts for her email, but she is 
becoming overwhelmed trying to keep up to date with all the email messages. After researching the 
various email clients available for Ubuntu, Mary has decided to use Thunderbird. This guide will 
follow Mary as she installs Thunderbird and imports her existing email accounts and messages.

Become a power user with tips and tricks

As Mary learns how to use Thunderbird, she picks up tips and tricks that make her 
work even more efficient. As she finds these hidden gems, she writes them down on 
sticky notes that you can see stuck to these pages. Using these can make a power 
user out of anyone, and help you to avoid potential problems.

Document conventions

While you work your way through this guide, there are a few document conventions that will help 
you along. By recognizing these conventions, you will be able to see at a glance which items are 
Thunderbird or Ubuntu components, terms that are defined in the Glossary, links to other parts of the 
guide, and hyperlinks to Web pages.

Convention Description Example

Bold Indicates a Thunderbird/Ubuntu 
component or menu item. Often, 
Thunderbird components are also 
defined in the Glossary.

In the Address Book, click File, point to 
New and click Address Book Contact.

Italic Indicates the word is defined in the 
Glossary. The first instance in each 
chapter of words defined in the 
Glossary are in italics.

Click the second drop-down list and select 
how you want to match the search criteria.

Italic-bold Indicates words that should be 
typed.

Type thunderbird into the search box.

Italic-underline Indicates a link to another section in 
the guide. A page number is also 
included. Clicking on the link will 
take you to the page.

For more information, see, “Grouping 
email folders with Unified Folders” on 
page 8.

Blue-underline Indicates links to Web sites. http://w  ww.meetup.com/ubuntuvancouver/  
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Getting further help

If you need more help setting up and using Thunderbird, the best 
source of information is the Mozilla Messaging support Web site: 
http://support.mozillamessaging.com
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2 Finding Your Way Around the Thunderbird Interface
Before we start following Mary in her quest to tame her email, we should probably take 
a look at what the various parts of the Thunderbird interface are called. Calling things, 
“the get mail or filter thingies”, might be fine for Mary, but will get awfully confusing if 
you don't know what she is referring to.

Here are the common names for the Thunderbird interface components so that we are all 
on the same page while we accompany Mary on her journey.

2.1  Main Thunderbird window

2.2  Message List Pane
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Figure 2: Message List Pane

Figure 1: Main Thunderbird window
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2.3  Message Pane

2.4  Address Book
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Figure 3: Message Pane

Figure 4: Address Book
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3 Getting Up and Running
Setting up Thunderbird is easy! While Ubuntu 10.10 doesn't come with 
Thunderbird pre-installed, the Ubuntu Software Centre makes getting it no 
problem. The Ubuntu Software Centre is the default tool to add or remove 
software in Ubuntu, and gives you access to thousands of applications configured 
to work with Ubuntu. After Mary installs Thunderbird, it takes her just a few steps 
to add new accounts and migrate any of her existing accounts.

3.1  Installing Thunderbird in Ubuntu 10.10
Installing Thunderbird is simple with the Ubuntu Software Centre. It is 
also the best way to install Thunderbird. You can go directly to the 
Mozilla Web site and download Thunderbird, but that isn't recommended. 
The version of Thunderbird that the Ubuntu Software Centre installs is 
specially customized to integrate fully with Ubuntu. For instance, newer 
versions of Ubuntu will automatically link the Indicator Applet to your 
Thunderbird email so that you can see when there are new email messages 
in your Inbox. However, the most important reason to use the Software 
Centre to install Thunderbird is that it has been tested to make sure it 
works seamlessly with Ubuntu.

To install Thunderbird with the Ubuntu Software Centre

1. Click Applications on the Ubuntu toolbar and select Ubuntu Software Centre.

2. In the Search box, type thunderbird and then select Mozilla Thunderbird Mail/News in the 
results.

3. Click the Install button.
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Figure 6: Ubuntu Software Centre

Figure 5: Ubuntu Software Centre

Tip!
The Ubuntu Software Centre is 
the best place to get any 
Ubuntu software. Take some 
time to browse through the 
categories and you'll probably 
find stuff you never knew you 
needed!
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4. If prompted for your Ubuntu user password, type it into the Authenticate dialog box and 
click Authenticate. The Ubuntu Software Centre will then proceed to install Thunderbird.

See, it's that easy! To run Thunderbird, select Mozilla Thunderbird Mail/News on the Ubuntu 
Applications – Internet menu.

3.2  Adding email accounts to Thunderbird
OK, Mary now has Thunderbird installed, but if she wants to actually use it, she needs to add email  
accounts. Mary already has a few email accounts that she uses and wants to add them into Thunderbird. 
Thunderbird is way ahead of her. The first time she opens Thunderbird, the program notices that there are 
no email accounts configured and starts the Mail Account Setup wizard to walk Mary through the process. 
The Mail Account Setup wizard can also be manually started by following the steps in the next 
procedure, To add email accounts with the Mail Account Setup wizard.

Thunderbird has a database of connection information for large Internet  
Service Providers (ISP) and webmail providers (e.g., Gmail, Yahoo!, 
MSN/Live/Hotmail) that it can use to automatically setup new email 
accounts. If the email account that Mary wants to set up is with one of 
these providers, all she needs to do is enter her name, email address and 
password, and Thunderbird does the rest. If the provider is not in the 
database, Mary can still configure the account manually.

To add email accounts with the Mail Account Setup wizard

1. On the File menu, point to New and then click Mail Account.

2. Type your name, email address and password in the Mail Account Setup dialog box, select 
Remember password and then click Continue.
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Figure 7: Authenticate dialog box

Figure 8: Mail Account Setup dialog box

Tip!
It may not be possible to set 
up free Yahoo! Mail accounts in 
Thunderbird. People have had 
mixed results getting them to 
work.
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3. Click Create Account if Thunderbird finds the configuration information for the email 
account and the account will automatically be set up. If Thunderbird does not find the 
configuration information, the next section describes manually configuring an account.

Manually creating an email account using the Mail Account Setup wizard

If the Thunderbird Mail Account Setup wizard fails to find the settings for your email provider in 
its database, you will need to manually configure the connection settings. 

Check with your email provider to make sure you have the correct information to configure the 
following settings:

• Your Password.

• Your Username.

• The name, type, port number and authentication type of the Incoming email server.

• The name, port number and authentication type of the Outgoing email server.
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Figure 9: Mail Account Setup automatic configuration

Figure 10: Failed Mail Account Setup
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To manually create a new email account in the Mail Account Setup wizard

1. Type the password you use to check mail into the Password box and select Remember 
password.

2. Type the user ID you use to check mail  into the Username box.

3. Type the name of the server you get mail from in Incoming.

4. Select the type of email server.

• POP (POP3)

• IMAP

5. Type the Incoming email server port number:

• Common port numbers are (confirm which port number your email provider uses):

◦ POP – 110 or 995

◦ IMAP – 143 or 993
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Figure 12: Mail Account Setup wizard

Figure 15: Mail Account Setup wizard

Figure 14: Mail Account Setup wizard

Figure 13: Mail Account Setup wizard

Figure 11: Mail Account Setup wizard
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6. Incoming email server authentication type:

• None – no authentication

• STARTTLS (this is what Thunderbird calls TLS authentication)

• SSL/TLS (this is what Thunderbird calls SSL authentication)

7. Outgoing email server name

8. Outgoing email server port number:

• Common port numbers are (confirm which port number your email provider uses):

◦ 25, 465 or 587

9. Select the Outgoing email server authentication type:

• None – no authentication

• STARTTLS (this is what Thunderbird calls TLS authentication)

• SSL/TLS (this is what Thunderbird calls SSL authentication)
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Figure 16: Mail Account Setup wizard

Figure 19: Mail Account Setup wizard

Figure 18: Mail Account Setup wizard

Figure 17: Mail Account Setup wizard
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10. Click the Re-test Configuration button to make sure that Thunderbird can successfully 
connect to the Incoming and Outgoing email servers, and then click Create Account.

Protecting your email account passwords

Mary has all of her email accounts setup now and they can successfully download her email 
messages. Because she told Thunderbird to remember the passwords for her accounts, she doesn't 
need to re-enter them each time she sends or receives email. However, Mary has discovered that 
Thunderbird stores those password in plain text in its preferences and on the computer's hard drive! 
If she leaves her computer logged in when she is not using it, anyone can open her Thunderbird 
preferences and see the passwords for all of her accounts! Thunderbird has thought of this and 
provides a mechanism to protect passwords from prying eyes; a Master Password.

When a Master Password is set, Thunderbird encrypts the email passwords stored on your 
computer and you must enter the Master Password each time you open Thunderbird. After you 
enter the Master Password, Thunderbird will automatically use your saved email passwords when 
sending or receiving email messages, but the passwords stored in Thunderbird's preferences and on 
your computer's hard disk remain encrypted.

Well, Mary doesn't have to worry about that any more. Now, if only she could figure out how to 
protect her computer from the coffee her co-workers insist on spilling on it!

o set a Master Password

1. On the Edit menu, click Preferences.

2. Click Security and select the Passwords tab.
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Figure 21: Thunderbird Preferences Passwords tab

Figure 20: Mail Account Setup wizard
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3. Select Use a master password.

4. Type the Master Password you want to use and re-type it to confirm you entered it 
correctly.

• Thunderbird provides a Password quality meter to show how strong a password is. 
If it is too low, your password may be easily guessed by people with nefarious 
intentions!

3.3  Importing email messages from existing email accounts
We will only be covering how to import from Gmail, Yahoo and MSN/Live/Hotmail webmail clients in 
this guide. These are some of the most commonly used email clients and you can import email messages 
from them without installing software not available on the Mozilla Thunderbird website. While there are 
tools that will allow you to import email messages from Evolution or Microsoft Outlook, they cannot be 
installed using Thunderbird. To import messages from other email clients without installing unsupported 
software, you can always forward them to a free webmail account like Gmail. Once in Gmail they can be 
be easily imported to Thunderbird. For more information on importing from Gmail, see “Importing email
from IMAP email accounts” on page 14.
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Figure 23: Change Master Password dialog box

Figure 22: Thunderbird Preferences Passwords tab

Tip!
Make sure that you 
remember the Master 
Password or you may lose 
access to all the email 
messages stored in 
Thunderbird!
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The email accounts that Mary has added already have important messages in them, and she wants to 
import the existing messages into Thunderbird. Before Mary can import those messages, she needs to 
understand the type of access email servers allow. 

There are two types of email accounts for receiving email messages, POP3 (Post Office Protocol ver. 3) 
and IMAP (Internet Message Access Protocol). There are many differences between the two types, but 
without getting into all sorts of 'technical-speak', lets take a look at the main differences. It is important to 
understand these differences when importing email messages.

With POP3, the your email provider allows you to download email messages from a single folder on their 
server, the Inbox. By default, when you check for email on a POP3 server with an email client like 
Thunderbird, the email messages are downloaded to your computer and removed from the server. This 
behaviour can be changed in your email client to leave the messages on the server, however, you still only 
download email messages from the Inbox. POP3 is essentially one-way communication; email messages 
move from the server to your computer. Examples of POP3 email services are Yahoo! Mail and 
MSN/Live/Hotmail. The majority of email providers only allow POP3 
access.

IMAP, on the other hand, allows you to download email messages from 
multiple folders on the server, leaving copies of the messages on the server 
that you can read from other computers. When you move messages between 
folders in Thunderbird, or create new folders, the changes are reflected on 
the server. You can think of IMAP as two-way communication; email 
messages and changes are synchronized between the server and your 
computer, including email messages sent from Thunderbird. An example of 
an IMAP email service is Google's Gmail.

Importing email from IMAP email accounts

Setting up a new IMAP email account, such as Gmail, and importing your existing email messages 
into Thunderbird couldn't be easier. By default, all your email and all the folders on Gmail are 
downloaded when you set the account up in Thunderbird. Thunderbird recommends this type of 
email account if the server supports both POP3 and IMAP.

Importing email from POP3 email accounts

If your previous email client, like Evolution, was Any messages in the Inbox will be downloaded to 
Thunderbird when you create the account. Often, however, Internet Service Providers that give you 
POP3 email accounts will also allow you webmail access and let you create folders on the server. 
Unfortunately, Thunderbird will only get email messages from the Inbox folder! If you want to 
import all of your email messages from these accounts, Google's Gmail comes to the rescue! Gmail 
has a tool that can log onto many POP3 email servers and import all the email messages and contacts 
for an account. It can even continue to watch the account for up to 30 days and import any new 
email messages it finds.

Gmail can't import your email messages and folders from your POP3 webmail account? Don't worry, 
you can still get all of your messages, it will just take a little more work. In order to get all the email 
messages stored on the server, all you have to do is use the webmail interface to move them into the 
Inbox so Thunderbird can download them. For more information on how to do this, see “To
manually import email messages from any POP3 webmail server” on page 15.
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It is important to be aware of 
how much space your email 
provider gives you if you use 
IMAP. All of your messages 
stay on the server until you 
delete them.
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Importing email messages from POP3 servers using Gmail

This is a huge help for Mary because she has an old Hotmail account that she wants to import 
the email messages from. Mary already has a Gmail account she can use, but if you don't, it is 
free to create one. For instructions on importing email messages and contacts into Gmail, and a 
list of email providers that it supports, please visit the following link. It will provide you with 
up-to-date information about using the Gmail import feature, as it may change at any time. If 
Gmail changes the link address and this one no longer works, you will need to search the 
Google Web site for current information. 

http://mail.google.com/support/bin/static.py?page=guide.cs&guide=25413&topic=25415

Once Mary has imported her Hotmail email messages and folders into Gmail, she can then 
download all the folders into Thunderbird using her Gmail IMAP account. If you use a POP3 
webmail service that Gmail can't import email messages from, it is still possible to manually 
import email messages from non-Inbox folders into Thunderbird using this procedure.

To manually import email messages from any POP3 webmail server

1. Set the account up in Thunderbird and move any messages in the Inbox into other 
folders.

2. Log into the POP3 webmail interface.

3. Ensure that there are no email messages left in the webmail Inbox.

4. Copy or move all the email messages from a folder into the webmail Inbox.

5. Check for new mail in Thunderbird to download the email messages in the Inbox.

6. Create a new folder in Thunderbird for the downloaded email messages.

7. Move the email messages from the Thunderbird Inbox into the new folder.

8. Repeat steps 3 – 7 for each additional folder in the webmail account.

3.4  Importing contacts from existing webmail accounts
It would be a shame if Mary has to re-create all the contacts that she has added to her existing webmail 
accounts just because she wants to use Thunderbird. It's a good thing that Gmail comes to the rescue 
again! All Mary has to do is to install a Thunderbird Extension that synchronizes her Gmail contacts with 
the Thunderbird Address Book. Extensions are additional features that can be added to Thunderbird.

The Google Contacts Extension will synchronize Mary's Gmail contacts with Thunderbird, and she can 
even get her Hotmail or other webmail contacts after using the Gmail import mail and contacts trick 
discussed earlier. To learn about this trick, see “Importing email messages from POP3 servers using
Gmail” on page 15.

Importing contacts with the Google Contacts Extension

Google Contacts, by H.Ogi, is a neat little Thunderbird Extension that synchronizes the Thunderbird 
contact lists with Gmail accounts. Gmail and Thunderbird contacts are updated when you make 
changes to either. If you want more information, please visit the H.Ogi Blog at:

http://hogiblog.blogspot.com/2008/05/synchronizing-google-contacts-and.html
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The first thing you should do before installing the Google Contacts Extension, is to backup your 
Thunderbird and Gmail contacts. When you install any third-party software, it's better safe than 
sorry! For more information about backing up your Gmail contacts, please refer to Google Help. To 
back up your Thunderbird Address Book you can use the following steps.

To backup the Thunderbird Address Book

1. Click Address Book on the Thunderbird toolbar.

2. On the Tools menu, click Export.

3. Type a name for the backup, select a location to save it to, and click Save.

16

Figure 25: Export Address Book

Figure 24: Address Book button
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To install the Google Contacts Extension

1. On the Tools menu, click Add-ons.

2. Type google contacts in the Search All Add-ons box and press ENTER.

3. Click Add to Thunderbird in the Google Contacts search result.

4. Click Install Now in the Software Installation dialog box.
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Figure 28: Software Installation dialog box

Figure 27: Add-ons

Figure 26: Add-ons
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5. Click the Restart Thunderbird button to finish the installation.

To setup the Google Contacts Extension

1. Once Thunderbird has restarted, click the OK button to set up Google Contacts.

2. On the General tab under Performance, specify the Maximum number of contacts 
you think you might need to retrieve from Gmail.

18

Figure 30: Set up Google Contacts

Figure 29: Install Complete dialog box

Figure 31: Google Contacts Preferences
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3. On the General tab under Accounts, select which Gmail accounts you want to 
synchronize with.

4. On the Conversion tab, select Convert postal address fields, select the address fields 
you want to synchronize and then click OK

5. Click Address Book on the Thunderbird toolbar.
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Figure 32: Google Contacts Preferences

Figure 33: Google Contacts Preferences

Figure 34: Address Book button
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6. Right-click on the Address Book toolbar and select Customize.

7. Drag the Reload button to the toolbar and click Done.
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Figure 36: Customize Address Book toolbar

Figure 35: Customize Address Book toolbar
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Using the Google Contacts Extension

Mary has the Google Contacts Extension installed and configured, and it has now downloaded 
all of her Gmail contacts into Thunderbird. 

Google Contacts has created a new address books group in Thunderbird's Address Book called 
Google-mary.dickens32@gmail.com. This is where Google Contacts puts all the Gmail 
synchronized contacts, regardless of what Gmail contact group they are in. When Mary adds a 
new contact to Thunderbird's Google-mary.dickens32@gmail.com Address Book, it is 
automatically added to her Gmail “Other Contacts” group in her webmail account. Any new 
contacts added in webmail to her Gmail account are not automatically synchronized with 
Thunderbird, however. Mary needs to click the Reload button that she added to the 
Thunderbird Address Book toolbar to synchronize them.

21

Figure 37: Gmail contacts Address Book
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3.5  A final word
Like many products, Mozilla Thunderbird and Ubuntu are constantly 
updating themselves and evolving. This guide was written for Ubuntu 10.10 
and Thunderbird 3.1, and future versions of the software will almost 
certainly have changes. If you find that things don't work quite the same way 
as was explained in this guide, you may need to visit the support site for the 
software, or your local users group.

The Mozilla Messaging Support Web site is a good place to find information 
about using Thunderbird, however, you may have better luck asking your 
questions about running Thunderbird on Ubuntu at the Ubuntu Vancouver 
LoCo. Ubuntu Vancouver LoCo is an Ubuntu users group for Vancouver, 
Canada. Being a local users group, the members and happy to help other 
locals learn the joy of Ubuntu. If you don't live in the Vancouver area, 
Meetup.com is a good place to find a users group near you. Launchpad can 
also be a valuable source of information about using Thunderbird and 
Ubuntu.

• Mozilla Messaging Support:

◦ http://www.mozillamessaging.com/en-US/support/  

• Ubuntu Vancouver LoCo:

◦ http://www.meetup.com/ubuntuvancouver/  

• Meetup.com

◦ http://www.meetup.com/  

• Launchpad:

◦ https://launchpad.net/  

So, there you have it! You have a shiny new installation of Thunderbird up and 
running on your computer. Now you can get down to the never-ending task of 
keeping up to all of your email messages. If you want to learn some of the 
tricks for dealing with your email avalanche, take a look at the companion 
document to this guide, Taming Your Email with Thunderbird 3.1. It can be 
found on the UVLC website under Discussions > Message Board > Technical 
Support:

http://www.meetup.com/ubuntuvancouver/messages/boards/forum/1245793

Good luck and happy emailing!
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Address Books Group A container in Thunderbird's Address Book used to group common 
email addresses.

AOL Mail A free, web-based email service provided by America On Line that 
allows users to receive, view, respond to and compose email 
messages using a Web browser.

Applet An Ubuntu software program that adds an icon to the Panel for 
launching applications and adding additional features.

Client Connects to a server to perform tasks or access data.

Computer Operating System Computer software that provides an environment and framework for 
other software programs to operate within.

Database A collection of data that allows for storing and searching.

Debian A version of the Linux computer operating system.

Decrypt Transform encrypted information, using an algorithm, into plain 
text.

Email Account A service, and the associated logon information, provided by an 
email provider that allows a user to send and receive email 
messages.

Email Client A computer software program that accesses email services on an 
email server.

Email Provider A company that provides users with access to email services.

Email Server A software program or computer that transfers email messages 
between computers on the Internet.

Encrypt To transform plain text information, using an algorithm, to make it 
unreadable without first decrypting it.

Evolution A free, open-source software program that contains tools for using 
email, contacts, calendars, notes and to-do lists.

23



Glossary

Extension (1) Computer software that adds additional features to Mozilla  
Thunderbird.

(2) The part of a computer file name after the final period, that 
indicates the type of data the file contains. For instance, “.txt” is 
commonly used to name text files.

Field Computer terminology that refers to a single piece of information in 
a group of related information. For instance, the sender's email 
address in an email message or the city in a postal address.

Firefox Free, open-source software developed by Mozilla to allow users to 
view and interact with Internet sites.

Gmail A web-based email service provided by Google.com that allows 
users to receive, view, respond to and compose email messages 
using a Web browser.

Gmail contact group A group of email addresses in Gmail that is the equivalent of 
Thunderbird's Address Book Groups.

GNOME See GNU Network Object Model Environment.

GNU A humorous recursive acronym that stands for “GNU's Not Unix”. 
A project to develop a free alternative to the UNIX computer  
operating system.

GNU Network Object Model 
Environment

Free, open-source software that provides a graphical user interface 
to computers running UNIX/Linux computer operating systems. 
Known by its abbreviation, Gnome.

GPL See GNU Public License.

GNU Public License The most widely used free software license.

Graphical User Interface Computer software that allows a user to interact with a computer  
operating system in a graphical, as opposed to text-based, manner.

Groupware Computer software that allows collaborative work by multiple users.

GUI See Graphical User Interface.

Hotmail See Live Hotmail.
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IMAP See Internet Message Access Protocol.

Indicator applet An Ubuntu software applet that communicates status information 
from various programs to the user.

Interface A computer hardware device or software that allows a user to 
communicate with the computer.

Internet Message Access 
Protocol

A communication language used by email servers and clients to 
transfer email messages over the Internet.

Internet Service Provider A company that provides users with access to, or a presence on, the 
Internet.

ISP See Internet Service Provider.

Launchpad An internet site, launchpad.net, that provides a suite of tools that 
allow people to communicate about computer software.

Linux A computer operating system developed by Linus Torvalds, based 
on UNIX and available for free under the GPL.

Live Hotmail A free, web-based email service provided by Microsoft that allows 
users to receive, view, respond to and compose email messages 
using a Web browser. Live Hotmail is commonly referred to as 
simply, Hotmail.

Logon User Name A computer user's identification used to access a computer or 
service. 

Macintosh A personal computer and computer operating system manufactured 
by Apple Inc.

Mozilla A computer software developer that produces non-profit Internet 
software. Officially known as the Mozilla Foundation.

Mozilla Messaging The division of the Mozilla Foundation that is responsible for the 
development of the Thunderbird email client.

MSN Hotmail A free, web-based email service provided by Microsoft that allows 
users to receive, view, respond to and compose email messages 
using a Web browser. MSN Hotmail is now called Live Hotmail, or 
simply, Hotmail.
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Newsgroup And Internet forum on the Usenet service containing messages 
discussing various topics.

Open-source Computer terminology for software that provides access to its 
programming “source code” and is licensed to allow modification 
and redistribution.

Panel An Ubuntu GUI component that provides easy access to desktops, 
applications, applets, and common configuration items.

Plain Text Text or information that is not encrypted.

POP Informal slang referring to downloading email from a POP3 email 
server. See also Post Office Protocol version 3

POP3 See Post Office Protocol version 3

Port (1) A software data connection that allows software to create virtual 
connections for communicating over the Internet.

(2) A computer hardware connector that allows external devices to 
be plugged to a computer.

Post Office Protocol version 3 A communication language used by email servers and clients to 
transfer email messages over the Internet.

Server A computer software program or computer that answers requests 
from a client.

Secure Sockets Layer An communication language developed by the Netscape 
Corporation to authenticate and encrypt communication over the 
Internet. See also SSL/TLS.

Snail Mail A slang term that refers to physical postal service mail.

SSL See Secure Sockets Layer.

SSL/TLS Thunderbird's term for SSL authentication/encryption. See also SSL.

STARTTLS Thunderbird's term for TLS authentication/encryption. See also TLS.

Thunderbird Free, open-source software developed by the Mozilla Foundation to 
receive, view, respond to and compose email or newsgroup 
messages.
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TLS See Transport Layer Security.

Transport Layer Security A communication language based on SSL to authenticate and 
encrypt communication over the Internet. See also STARTTLS.

Ubuntu (1) A free, open-source computer operating system based on Debian 
GNU/Unix.

(2) The Southern African Bantu word for an ethical ideology that 
promotes humanity towards others. 

Ubuntu Vancouver Local 
Community

A computer users group in Vancouver, Canada, focusing on the 
Ubuntu Linux computer operating system.

Ubuntu Vancouver LoCo See Ubuntu Vancouver Local Community.

UNIX A trademark for a computer operating system, developed in 1969 at 
the AT&T Bell Laboratories, that can be used by more than one 
person at a time.

Usenet An Internet communication system that transmits news and 
discussions.

Username See Logon User Name

UVLC See Ubuntu Vancouver Local Community

Webmail An Internet-based service that allows users to receive, view, respond 
to and compose email messages using a Web browser.

Windows A computer operating system GUI developed by Microsoft Inc.

Wizard A software program that guides a user through a task.

Yahoo! Mail A free, Internet-based service provided by Yahoo.com that allows 
users to receive, view, respond to and compose email messages 
using a Web browser.

Yahoo! Mail Plus A commercial, Internet-based service provided by Yahoo.com that 
allows users to receive, view, respond to and compose email 
messages using a Web browser.
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